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Define your database

When you launch VSP, it's helpful to re-label the headings on the

left-hand side to more accurately reflect Kettle Campaign schedules.

We will use the Jobs pane to manage the locations of your kettles.

1. Click the “Edit” menu at the top of the VSP window.
2. Select “Change label used for ‘Job.”

3. Change the word “Job” to “Kettle” (enter the singular

form of the word and VSP will pluralize as needed).
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6 Enter your Kettles

For each shift, you will be able to specify how many volunteers
should be scheduled for each Kettle.

1. Click on the Kettles pane.
2. Click the “+" button and select “New Kettle.”
3. Add the name of the location.

4. To ensure all volunteers can easily sign up for any location,
check the option that says, “Qualify new volunteers for
this kettle location by default”

5. Optionally add subdivisions if there is more than one

Kettle at the same location.

6. Repeat this process for each kettle location you will
be scheduling.
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Creating a schedule

After you have entered all your Kettles, create a schedule. Note that
all the shifts and jobs that will occur within this time period will be

included on this “master schedule.”

1. Click on the Schedules pane.

2. Enter the start and end dates for a schedule, and then

click the “Create...” button.

3. Click on a day in the calendar on which one of your shifts
takes place, and then click the “New Shift...” button at the

top of the window.

4. In the dialog that appears, set the start and end time for
the shift.

5. If the shift repeats on other days of the week, or monthly
or yearly, use the controls under the “Repeats” heading to

set up the appropriate repeating pattern.

6. Specify how many volunteers from each Kettle are
required for this shift.

7. Click “OK”

8. Repeat this process for all your other shifts.

When you have finished creating all your shifts:

1. Choose “Save” from the File menu at the top of the

schedule window.

2. A dialog will open asking you to enter a name for the
schedule. Be sure the box is checked to “Make this
schedule live now” and select the option to “Just use the

default layout for now.”

3. Click “OK”

This schedule will be saved to the VSP web servers. To open it later, click on the
Schedules pane on the left hand side of VSP's main screen.

Please choose a name for this schedule:
Schedule Nov 25 - Dec 24, 2022

B Make this schedule live now so volunteers can see their assignments online
When a schedule is live, volunteers can see their scheduled times in the Web
Terminal and sign up for unfilled positions. (If you don't make this schedule live
now, you can do so later by choosing "Make schedule live" from the File

| O customize the online layout ("Live Schedule Post") now (what's this?)
© Just use the default layout for now (can be changed later)

| Cancel




Enter your volunteers

“Volunteer” refers to any person who will be scheduled at any Kettle

location. There are several ways to go about entering your volunteers:

\ERIEWYA enter volunteers to customize their
complete profile.

1. Click the “+” button on the right side of the

Volunteers pane.

2. Add the volunteer name, email, and any other
information you want to track about
that volunteer.
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We recommend importing one spreadsheet per job so you
can quickly qualify volunteers for their jobs during import.
Watch this video to learn how to set up a spreadsheet and

import your volunteers.

1. Go to File - Import Volunteers.

2. From the available fields, select the fields
to import in the order they appear on

your spreadsheet.

3. Choose whether to qualify everyone from the

spreadsheet in a particular job.

4. Click the “Import” and choose your spreadsheet.


https://www.volunteerschedulerpro.com/video/80

TIP

to a list of contacts Recommended settings

As people enroll, they are added as volunteers to the database. The remaining settings on the right-hand side of

Watch this video for a walkthrough of the full enrollment form the dialog are used to track volunteer availability

setup process. and preferences. You will not need to use these
sections if you are primarily having volunteers

To see the enrollment form: sign up for shifts online. You will only need

1. Click on the Web Terminal pane on the left hand side to use the “Shift preferences” and “Preferred
of VSP’s main screen. serving frequency” sections if you are using the
2. At the top of the pane, click “Web Terminal Settings” availability-based rotation model.

and then click the Enrollments pane on the left.

3. The Enrollment URL at the top is the direct link to
your form, You can click this to view or to send to

your volunteers.


https://www.volunteerschedulerpro.com/video/86

Scheduling volunteers

VSP accommodates many forms of scheduling, but there are two
common methods used to schedule Kettle Campaigns: self sign-up

and manual.

= #5150 Volunteers sign up for shifts online m Handpick the volunteers you want to serve and
get notification of any potential conflicts

1. Click the “Log in as...” button found in the lower right-
hand corner of the Web Terminal pane. 1. Open the saved schedule you created in step 3 of

2. Choose a volunteer to login to the Web Terminal as if you these instructions.

were that person. 2. Click on one of the empty positions in a shift, and you'll

3. Click on the “Full Schedules” tab at the top of the page see that the volunteer list on the right side of the window

and then click on an unfilled position to sign up for a shift shows the volunteers who are eligible and available to fill

. . L the selected position.
4. Once you submit the request, go back into VSP (minimize

or close the web browser window) and click on the Web 3. To fill the position with one of the volunteers in the list,

Forms pane on the left-hand side of VSP’s main screen. double-click or drag-and-drop the volunteer whom you

You'll see an “Assignment form” in the list that represents wish to assign.
the assignment request you submitted online. Click the

“Process Form” button.

5. You can optionally set up these forms to be automatically
processed so that the assignments are made in real time as

soon as the forms are submitted.


https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically
https://rotundasoftware.screenstepslive.com/s/VSP/m/58335/l/717677-how-can-i-set-up-my-web-forms-to-process-automatically

TIP

Customizing VSP for your organization

Web Terminal settings allow you to further customize how
volunteers interact with VSP through the Web Terminal. (NOTE: Web

Terminal settings are not available during the 15-day free trial.)

Custom fields, available in the Standard edition, can be used to
collect and track volunteer information that is not reflected in the
predetermined fields within VSP. Examples of common custom fields
include t-shirt size, birthday, certifications, and more. Custom fields
can be added to the enrollment form and the My Profile form so that 1. Click on the Web Terminal pane on the left-hand side of
volunteers can update these fields themselves online. T e e —

2. Click the “Web Terminal Settings” button at the top of the

Click here for a video on how to set up custom fields.
Home tab.

1. Go to the Volunteers pane and click “New Volunteer..." In the dialog that appears, you will find a variety of customization

2. In the new window, click the “Edit Custom options. Among many other options, you can:

Fields...” button.

3. Click the “Create New Field” button.

4. You have different options for custom fields: text,
number, date, checkbox, and list of options. Once
you create the field it will appear in the main part of

the screen.

5. Click “OK” once you have added all the custom fields you

wish to track.

e Customize the text of automatic email reminders
e Turn on automatic text message (SMS) reminders

e Turn on automatic processing for web forms, so that
requests that volunteers make through the Web Terminal
are processed immediately rather than held for manual

processing at a later time.
e Brand the Web Terminal with your organization’s logo

e Customize the profile information that volunteers can
update in the My Profile tab. For instance, you can hide
the shift preferences and unavailable times areas, or you

may include custom fields on the My Profile tab.


https://www.volunteerschedulerpro.com/video/92

Giving volunteers online access s prsn. ek s G 0 g e
to the Web Terminal

New scheduling system and scheduled dates shannon Anderson
Nancy Austin

. Dear Nancy Austin, Clifford Baker
When you are ready, send your volunteers an email through the _ Theodore Beck
We are pleased to announce that we'll be using an online system that
Announcements pane to let them know how to |Og in to the Web allows you to specify the times that do and do not work well for you to Allen Bennett
serve, check your schedule from anywhere and easily find a substitute Annie Bowman
. . when you can't make it. For information and help on how to use this N
Termlnal' (NOTE YOU can Set Up Announcements bUt you CannOt system, please watch this short video or refer to this printable guide. Victoria Bowman
. . Angela Bradley
Send them d uring the 1 S'day free tr|a|.) After watching the video, you can log in to the "Web Terminal" using the Patrick Bradley
link below. Roy Bradiey
https://secure.rotundasoftware.com/29/web-terminal/home?user=VSsp Amy Brewer
1. Click on the Announcements pane on the left-hand side Username: naustin sarah Brooks
, . Password: 2h1t3h Theresa Brown
of VSP’s main screen. Craig Burke

Don't forget that if you have an iOS or Android device, you can use the VSP
. - . . mobile app! After downloading, you'll need the following Organization 1D
2. Click the “+” button in the upper right and select tosign in: VSP Laura Campbell

Enter your Web Terminal Username and Password to log in. Martin Campbell

Todd Burns.

“Templates” and then “Preconfigured.”

Earl Carr -

Then, all you need to do is open the VSP app to see your scheduled dates,
request and accept subs, and update your profile! Show only final recipients

3. Select one of the “Introductory email” templates to send

your volunteers that will provide them with the link to
your Web Terminal homepage and their personal -

usernames and passwords that are automaticall
P y We also recommend that you post a link to your Web Terminal’s

generated for them by VSP. Tokens enclosed in {{curly L .
home page on your organization’s website so that your volunteers

brackets}} will be replaced with the appropriate . o e
can access their schedules by visiting your organization’s site.

information for each volunteer when the email is sent.

Feel free to customize the email to best suit your

organization’s needs - you can add and remove text and 1. Go to the Web Terminal pane on VSP’s main screen and

tokens as needed by typing into the text box. then click the “Copy URL” button in the top right corner

of the pane.
4. Click the “Preview” button, then click on a

. . . )
volunteer’s name to see how the email will look when sent 2. Send an email to your organization’s webmaster and

to each volunteer choose “Paste” from the “Edit” menu to paste the link into

the email with a request to post it on your site.



Conclusion

Congratulations! You have completed the setup work of entering your jobs, creating a schedule, and adding volunteers. You should now

have a clearer idea of how VSP can work for your organization.
For more help getting started with VSP, visit our Help Center. There, you will find:

e Video tutorials on specific features in the program, including those not covered in this guide, such as how to print the

schedule, customize the online layouts, and send text messages

e Step-by-step instructions for many common questions and setups

e The user manual, which helps explain the many different options found within the program

Need additional help?
Contact support by sending in your data files (Help - Send Data Files to Tech Support) or call us at 888-877-3640.

We also have guides available Salvation Army Kettles, Adoration, or events.
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https://www.volunteerschedulerpro.com/resources/events-QuickStartGuide.pdf

